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Preface

The Solstice Backup 6.0 Installation Guide provides instructions on how to install 
Solstice Backup™ software.

After you install the Solstice Backup software, refer to the Solstice Backup 6.0 
Administrator’s Guide and the program’s online help for detailed instructions on how 
to configure, administer, and use the Solstice Backup software.

The information in this guide is intended for system administrators who are 
responsible for installing software and maintaining the servers and clients on a 
network. Operators who monitor the daily backups may also find this manual 
useful.

Before You Read This Book
In order to fully use the information in this document, you must have thorough 
knowledge of the topics discussed in these books:

■ Solstice Backup 6.0 Adminstrator’s Guide
■ Solstice Backup 6.0 Release Notes
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Using UNIX Commands
This document may not contain information on basic UNIX® commands and 
procedures such as shutting down the system, booting the system, and configuring 
devices.

See one or more of the following for this information:

■ Solaris Handbook for Sun Peripherals

■ AnswerBook2™ online documentation for the Solaris™ operating environment

■ Other software documentation that you received with your system

Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files, 
and directories; on-screen 
computer output

Edit your .login file.
Use ls -a to list all files.
% You have mail.

AaBbCc123 What you type, when 
contrasted with on-screen 
computer output

% su
Password:

AaBbCc123 Book titles, new words or terms, 
words to be emphasized

Command-line variable; replace 
with a real name or value

Read Chapter 6 in the User’s Guide.
These are called class options.
You must be superuser to do this.

To delete a file, type rm filename.
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Shell Prompts

Related Documentation

Accessing Sun Documentation Online
The docs.sun.comsm web site enables you to access a select group of Sun technical 
documentation on the Web. You can browse the docs.sun.com archive or search 
for a specific book title or subject at:

http://docs.sun.com

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #

Application Title Part Number

Administration Solstice Backup 6.0 Administrator’s Guide 806-5607-10

Release Notes Solstice Backup 6.0 Release Notes 806-5610-11 
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Ordering Sun Documentation
Fatbrain.com, an Internet professional bookstore, stocks select product 
documentation from Sun Microsystems, Inc. 

For a list of documents and how to order them, visit the Sun Documentation Center 
on Fatbrain.com at:

http://www.fatbrain.com/documentation/sun

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and 
suggestions. You can email your comments to Sun at:

docfeedback@sun.com

Please include the part number (806-5608-11) of your document in the subject line of 
your email.
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CHAPTER 1

Introduction

This chapter provides background information on Solstice Backup software and 
supported devices. It includes the following sections:

■ “About the Solstice Backup Product”  

■ “Supported Devices” on page 3

■ “Enabler Codes” on page 3

About the Solstice Backup Product
The Solstice Backup product is a suite of storage management software that provides 
backup, recovery, and other services to computers with a wide variety of operating 
systems and data types. Solstice Backup products for different operating systems are 
interoperable, which provides you with flexibility in designing a storage 
management setup that works best with your current computing environment.

The Solstice Backup software is distribued in a media kit of CD-ROMs that contain 
the software and electronic documentation for several related Sun products

The Solstice Backup product comprises three applications: the Solstice Backup 
server, client, and storage node.

Solstice Backup Server
The Solstice Backup server software provides control and scheduling for Solstice 
Backup operations. On the Solstice Backup server, you perform the following 
operations:
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■ Enter the enabler licenses for the Solstice Backup server and all the functions the 
Solstice Backup server controls, such as autochanger modules, additional client 
connections, and Legato ClientPak licenses.

■ Define the clients, devices, and media that the Solstice Backup server controls.

■ Define the schedules for backups and other operations.

■ Monitor the results of backups and other operations.

■ Manage the indexes that track which data belongs to which client and which 
media contains which data.

Solstice Backup Client
The Solstice Backup client software provides recover and on-demand backup 
functionality, and it communicates with the Solstice Backup server. You install the 
Solstice Backup client software on all computers that you want to back up to the 
Solstice Backup server. 

Solstice Backup clients do not have to be of the same operating system as the Solstice 
Backup server. However, to back up clients of other operating systems, your Solstice 
Backup server must have a Legato ClientPak enabler for that type of client. For 
example, the Solstice Backup server is allowed to back up Solstice Backup clients on 
the Solaris™ operating system, but if you also want to back up Solstice Backup 
clients on another operating system, you must purchase and enter the Legato 
ClientPak enabler for that operating system.

Solstice Backup Storage Node
You can back up data directly to devices attached to either a Solstice Backup server 
or to a Solstice Backup storage node. A storage node controls storage devices such as 
tape drivers, autochangers, and silos. 

Storage nodes depend on the Solstice Backup server for the following functions:

■ Control over which clients use the storage node’s devices for backups

■ License management

■ Management of the indexes that tracks data belonging to a client and the media 
containing the data
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Supported Devices
Sun Solstice Backup software supports a variety of media types and devices, either 
stand-alone or in an autochanger or silo tape library. Devices can be attached to a 
Solstice Backup server or a designated storage node. To obtain the latest list of 
supported devices, refer to the Legato Compatibility Guides on the Legato web site. 

You must use a nonrewinding device for Solstice Backup backups. The pathnames 
for these devices must follow the Berkeley Storage Device (BSD) semantic rules, for 
example, /dev/rmt/0mbn. The “b” in the pathname satisfies the BSD semantics 
requirement. If you use a file device, you must enter it as a directory path (the same 
as for other device types) rather than as just a filename.

The Solstice Backup application writes a file mark on the volume at the end of each 
backup. When the next backup occurs, the Solstice Backup application appends data 
to the volume based on the position of the file mark. If a device automatically 
rewinds the data, the file mark position is lost and the next backup overwrites the 
data; you will be unable to recover the previous backup data.

The Solstice Backup application uses the following naming standard to indicate a 
nonrewinding device:

Enabler Codes
Enabler codes (licenses), which activate the functionality of Solstice Backup software 
and other Sun software, are sold separately. For more information, see Chapter 4.

no_rewind_example=/dev/rmt/Ombn
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CHAPTER 2

Installing the Solstice Backup 
Software on Solaris

This chapter explains how to install the Solstice Backup software. It includes the 
following sections:

■ “Software Installation Roadmap” 

■ “Installation Requirements” on page 6

■ “Updating from a Previous Release” on page 9

■ “Autochanger” on page 20

■ “Verifying Your Installation” on page 23

■ “Removing the Solstice Backup Software” on page 25

Software Installation Roadmap
The following numbered tasks are a roadmap to follow when installing the Solstice 
Backup software. Read the roadmap and the referenced sections before installing 
Solstice Backup software:

1. Review the requirements section and note the default directory location and the 
software installation file space requirements. For more information, see 
“Installation Requirements” on page 6.

2. If you have an earlier release of Solstice Backup software installed see “Updating 
from a Previous Release” on page 9.

3. Install the required Solstice Backup software. For more detailed information, see 
“Installing the Software” on page 13.

4. Install the device drivers for the Solstice Backup server and any storage nodes. 
For more detailed information, refer to the following sources:
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■ “Autochanger” on page 20 

■ The autochanger and silo chapters in the Solstice Backup 6.0 Administrator’s 
Guide

5. Enable and register all of your Solstice Backup products. For more information, 
see Chapter 4.

Installation Requirements
The system requirements differ for each of the installation types listed below. For 
more information, see the following sections:

■ “Client Software” 

■ “Storage Node” on page 7

■ “Server Software” on page 8 

Caution – Solstice Backup software does not support locales (defined by your 
operating system) or codesets that remap characters having special meaning for 
filesystems. Depending on the filesystem, these special characters may include the 
forwardslash (/), the backslash (\), the colon (:), or the period(.). De_DE.646 is an 
example of one unsupported locale.

Solstice Backup software might function normally in such an environment, but 
might not function normally if the locale is changed (the previously existing indexes 
can become invalid). Changing between supported locales is not a problem.

Client Software
The following sections describe Solstice Backup client software installation 
requirements:

■ “System Requirements”  

■ “Client Backup and Recovery Guidelines” 

System Requirements

The installation requirements differ, depending on whether or not the clients have 
the same operating system as the Solstice Backup server.
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The Solstice Backup client package temporarily requires 70 MB of free space on the 
client computer.

To install software on clients:

■ Of the same operating system, use the same installation media used to install the 
Solstice Backup server.

■ Of different operating systems, use the Solstice Backup client software for that 
operating system on each client computer and purchase the required Legato 
ClientPak enabler code. For more information, refer to the appropriate installation 
guide.

Client Backup and Recovery Guidelines

In order for Solstice Backup clients to use the Solstice Backup server to back up and 
recover files, they must be able to access the Solstice Backup software.

A client can access the Solstice Backup software in one of two ways:

■ Clients are installed with Solstice Backup programs directly on their local disks.

■ Clients are configured with an NFS-mounted directory on the remote system 
where the Solstice Backup programs are located.

To back up a Solstice Backup client, the nsrexecd daemon must be active on the 
client. To avoid errors during a scheduled backup of the client, make sure that the 
nsrexecd command is in each client’s startup file.

Storage Node
A storage node must have at least one storage device attached and installed 
according to the manufacturer’s instructions. Storage devices must be supported by 
Solstice Backup software.

Caution – To successfully install the Solstice Backup server and storage node, you 
must also install the device driver software (SUNWsbus2). For more information, see 
“Autochanger” on page 20.

Solstice Backup storage node supports a variety of media types, including: 

■ 4 mm

■ 8 mm

■ Optical disk

■ Digital linear tape (DLT)
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■ Disk file

Solstice Backup software also supports a wide variety of devices attached to a 
Solstice Backup server or a designated storage node, either as a stand-alone device 
or in an autochanger or silo tape library.

For a list of supported devices, obtain the Legato Compatibility Guides from the 
Legato web site at www.legato.com.

Server Software
This section describes Solstice Backup server installation requirements:

■ “System Requirements”  

■ “Installation Guidelines” on page 9

System Requirements

To install Solstice Backup software on a Solaris server, your system must have the 
space recommended in TABLE 2-1 and meet the following requirements.

Make sure that:

■ You have a directory on the server large enough for the Solstice Backup client and 
server indexes and media database (usually /nsr). The installation script checks 
for space and suggests one or more locations for the indexes and media database.

■ You know the system pathname of at least one storage device for use by the 
Solstice Backup server to back up and recover files. 

If you use a tape device to back up data you must use a valid pathname for that 
device. For example:

/dev/rmt/0cbn

Note that the tape device must be nonrewinding. 

To read the PDF files you need  Acrobat Reader. To install Acrobat Reader, you need 
a directory with enough space to install the Acrobat Reader software included with 
the Solstice Backup distribution files.
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Installation Guidelines

On the system you are designating as the Solstice Backup server, you must install all 
of the Solstice Backup software: client, storage node, server, and device drivers. Sun 
recommends that you install all of the Solstice Backup software on the server at the 
same time. 

If you accept the default locations, the installation script chooses the directory 
locations shown in TABLE 2-1.

Updating from a Previous Release
The following sections explain how to update from a previous release of Solstice 
Backup software:

■ “Introduction” 

■ “Disk Space Requirements” 

■ “To Update from a Previous Version of Solstice Backup” 

■ “To Restore the Media Database and Configuration Files” 

TABLE 2-1 Default Locations and Space Requirements

Software/Documentation Files
Solstice Backup Server Default 
Location Space Needed

Solstice Backup GUI program files /usr/bin/nsr 23 MB

Solstice Backup daemon and utility 
command files

/usr/sbin/nsr 22 MB

Online client file indexes; media 
database

/nsr varies

Solstice Backup device drivers /etc/LGTOuscsi
/usr/kernel/drv
/usr/kernel/drv/sparcv9
/usr/lib/nsr

21 MB

Solstice Backup man pages /usr/share/man 1 MB

Adobe Acrobat Reader /opt/Acrobat3/bin 8 MB

PDF files optional varies
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Introduction
When you update Solstice Backup release 4.2 or later to release 6.0, the following 
files are automatically converted to a new database format the first time you start 
the Solstice Backup daemons:

■ Client file indexes

■ Media database

To update from releases 4.1 and earlier, you must restore the client file indexes, 
media database, and configuration files from backup. For more information, see “To 
Restore the Media Database and Configuration Files” on page 12. 

Updating from corrupted indexes is not supported. 

Caution – Once the client-file indexes, server indexes, and media database have 
been upgraded to the new Solstice Backup 6.0 database format, there is no way to 
return to a previous release of Solstice Backup software. It is a one-way conversion 
with no provision for undo.

Disk Space Requirements
The Solstice Backup 6.0 index conversion requires that there be at least enough free 
disk space as the largest pre-6.0 release index. This space is used during the 
conversion process and will be released. Following conversion, expect that the 
media database may be about twice its previous size. The client file indexes will be 
reduced in size by 20 to 40 percent. This change in storage requirements is 
permanent.

▼ To Update from a Previous Version of Solstice 
Backup
1. If necessary, perform a scheduled backup (not a manual backup) or wait to 

upgrade until after a scheduled backup. Make sure that you have a current full, 
incremental, or level 0 backup of the:

■ File indexes (/nsr/index)

■ Server resource files (/nsr/res)

■ Media database (/nsr/mm)
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Caution – You need the bootstrap information to complete the “To Restore the 
Media Database and Configuration Files”  section. Make sure you have this 
information before continuing with step 2.

To get the bootstrap information from:
-Solstice Backup 5.0 and later, use the mminfo -B command.
-Releases prior to Solstice Backup 5.0, use the mminfo command as shown:
# mminfo -N bootstrap -t ‘ 5 weeks ago’ -ot -r 
‘ savetime,level,ssid,mediafile,volume’

Caution – The Solstice Backup packages have dependencies and must be deleted in 
the correct order. The correct order for deletion is: server, storage node, and then 
client. The man page package has no dependencies and can be deleted at any time.

2. Remove the earlier Solstice Backup release (but not the indexes, resource files, or 
media database). For more information, see “Removing the Solstice Backup 
Software” on page 25.

3. Install the new release of the Solstice Backup software. For more information, see 
“Installing the Software” on page 13.

4. Enable and register your Solstice Backup software. For more information, see 
Chapter 4.

If you did not have enough disk space to automatically convert the indexes, you can 
restore them. For more information, see “To Restore the Media Database and 
Configuration Files” on page 12.

Enhancing Client File Conversion

While Solstice Backup software is in the process of converting the client file indexes 
serially, you can manually start the conversion of any specific client file index.

To start multiple client file index conversions in parallel, run multiple instances of 
the nsrck program concurrently:

■ Specify which client’s file index to convert. For example:

# nsrck client_name

or

■ Enter the nsrck command without a client name. This initaites the conversion of 
the next client in the list.
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Note: Each instance of nsrck running occupies a portion of your server’s processing, 
memory, and space swapping capability. You must balance the speed with which 
you want to convert your indexes against other Solstice Backup server needs. You 
should also monitor your system performance using a diagnostic tool to determine 
the optimum number of nsrck instances to launch.

▼ To Restore the Media Database and 
Configuration Files
With the new release of the Solstice Backup software installed, you have the option 
of restoring your old indexes, media database, and configuration files from the 
backup media. The /nsr/res directory, which contains the configuration files, 
cannot be reliably overwritten while Solstice Backup software is running; therefore, 
mmrecov recovers the /nsr/res directory as /nsr/res.R.

1. Find the bootstrap information (required for the next two steps). The mmrecov 
program asks you for the bootstrap save set identification number (ssid). 

■ If you perform regular scheduled backups that include the server, you should 
have a copy of the bootstrap file (either as hard copy or an electronic file) with 
the name of the backup media you need and the bootstrap ssid. 

■ If you do not have this information available, enter the scanner -B command 
at the shell prompt to obtain the bootstrap ssid. You must have the volume 
containing the most recent bootstrap in a working drive.

2. Retrieve the backup media that contains the most recent backup named bootstrap 
and load it into the server’s backup device.

3. Enter the mmrecov command to extract the contents of the bootstrap backup. 
The mmrecov program prompts you for the:

■ Latest bootstrap ssid

■ Starting file number (if known)

■ Starting record number (if known)

■ Volume on which the ssid started

If you have more than one backup device available, the mmrecov program also 
prompts you to enter the name of the device you want to use. You can press 
[Enter] to accept any default values that they mmrecov program provides at each 
prompt. 

The Solstice Backup media database and resource configuration files are 
recovered when the following message appears:

If your resource files were lost, they are now recovered in 
the ‘res.R’ directory. 
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Copy or move them to the ‘res’ directory, after you have shut 
down the service. Then restart the service. Otherwise, just 
restart the service. 

If the on-line index for the [server_name] was lost, it can be 
recovered using the nsrck command.

For more information about the mmrecov  command and examples of its output, 
refer to the Legato NetWorker Disaster Recovery Guide or the mmrecov  man page.

4. Use Solstice Backup commands such as nsrwatch  or nwadmin to monitor the 
progress of the server during the recovery of the index and configuration files, if 
necessary.

5. When the recovery process is complete:

a. Shut down the Solstice Backup daemons:

# nsr_shutdown

b. Copy the contents of the /nsr/res.R  directory to the /nsr/res  directory. 

c. Delete the /nsr/res.R  directory. 

d. Restart Solstice Backup. For example:

# /etc/init.d/networker start

6. Use the nsrck command with the -L7  option to recover the client file indexes. 
For example:

Once the recovery of a client file index is completed, you can browse it and select 
specific items for recovery.

Installing the Software
The following sections explain how to install a Solstice Backup server, client, and 
storage node from either a CD-ROM or a downloaded file:

■ “Accessing the Installation Files” 

■ “Installing to Default Locations” on page 15

■ “Installing to a Nondefault Location” on page 19

# nsrck -L7
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Accessing the Installation Files
This section explains how to access the Solstice Backup from the follow media 
locations:

■ “To Access Installation Files From a Local CD-ROM” 

■ “To Access Installation Files From a Remote CD-ROM” 

▼ To Access Installation Files From a Local CD-ROM

To access the Solstice Backup software on a system with a local CD-ROM drive 
attached:

1. Log in as root on the system where you are installing the Solstice Backup 
software.

2. Locate the Solaris directory on the installation CD-ROM.

3. Set the PATH environment variable for the user root, on both the Solstice Backup 
server and client, to contain the directory where the Solstice Backup executables 
reside:

▼ To Access Installation Files From a Remote CD-ROM

To access the Solstice Backup software from a remote CD-ROM drive:

1. Insert the CD-ROM into the remote system’s drive.

2. Mount the CD-ROM on the remote system.

3. Make the mounted CD-ROM exportable through NFS.

4. Log in as root on the system where you are installing the Solstice Backup 
software.

5. Create a mount point:

6. Mount the filesystem containing the mounted CD-ROM onto the system where 
you are installing Solstice Backup software:

$PATH:/usr/bin/nsr:/usr/sbin/nsr

# mkdir /tmpmntdir

# mount remote-host:/cdrom/6.0.SBU /tmpmntdir
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7. Set the PATH environment variable for the user root, on both the Solstice Backup 
server and client, to contain the directory where the Solstice Backup executables 
reside:

Installing to Default Locations
This section explains how to install the server, client, and storage node software:

▼ To Install a Solstice Backup Client

To install Solstice Backup software on the computer that you are designating as the 
Solstice Backup client:

1. Enter the pkgadd command at the system prompt. For example:

Caution – Do not press the [Enter] key for the default response “all.” Accepting the 
default installs the server and the device driver packages.

2. At the prompt, enter the appropriate option number to install the client package 
(SUNWsbuc). The package temporarily requires 70 MB of free space on the client 
computer.

3. At the prompt, enter the appropriate options number to install the man pages, 
(SUNWsbum) (optional).

4. When you have added all the applicable packages and the prompt is displayed, 
enter q to exit.

5. If you did not specify a set of Solstice Backup servers during the Solstice Backup 
client installation but you want to limit the servers authorized to access the client, 
you can specify a list of trusted Solstice Backup servers for your client using the /
nsr/res/servers file.

Note: You can also use the following procedure to change the set of Solstice 
Backup servers that are authorized to access this client.

a. Shut down the Solstice Backup daemons. For example:

# nsr_shutdown

$PATH:/usr/bin/nsr:/usr/sbin/nsr

# pkgadd -d /cdrom/6.0.SBU/SOLARIS/Sparc
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b. Edit or create the /nsr/res/servers file and add the set of Solstice Backup 
servers, one per line, that you want to grant access to this client. The first entry 
in this file becomes the default Solstice Backup server. 

c. Check the Solstice Backup boot-time startup file for nsrexecd -s arguments. 
If they exist, delete the -s arguments. The nsrexecd -s argument supercedes 
the /nsr/res/servers file. 

For example, delete the arguments for nsrexecd -s in the file shown below:

# vi /etc/init.d/networker

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

d. Use the Solstice Backup boot-time startup file to restart the Solstice Backup 
software. For example:

# /etc/init.d/networker start

▼ To Install a Solstice Backup Storage Node

To install Solstice Backup software on the computer that you are designating as the 
Solstice Backup storage node and have purchased an enabler code for:

1. Install the Solstice Backup client (SUNWsbuc) software. For details see “To Install 
a Solstice Backup Client” on page 15.

2. Enter the pkgadd command at the system prompt. For example:

3. At the prompt, enter the appropriate option number to install the following:

■ Device driver (SUNWsbus2) 

■ Storage node (SUNWsbun)

4. When you have added all the applicable packages and the prompt is displayed, 
enter q to exit.

5. Configure the driver software to provide support for Solstice Backup software to 
back up data to the SCSI storage devices attached to the system. For more 
information, see “Autochanger Configuration and Testing” on page 21. 

For the latest information about supported devices, refer to the Legato Compatibility 
Guides on the Legato web site.

# pkgadd -d /cdrom/6.0.SBU/SOLARIS/Sparc
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■ “To Install the Solstice Backup Server” 

■ “To Install a Solstice Backup Client” on page 15

■ “To Install a Solstice Backup Storage Node” on page 16

▼ To Install the Solstice Backup Server

To install Solstice Backup software on the computer that you are designating as the 
Solstice Backup server:

1. Keep a copy of your current configuration. The Solstice Backup software 
installation script modifies the following files during the installation process.

■ /etc/rpc

■ /etc/syslog.conf

For example:

2. Enter the pkgadd command at the system prompt. For example:

3. At the prompt, press [Enter] to install all of the packages on the server. Sun 
recommends that you install all of the Solstice Backup software on the server at 
the same time.

You can override the default selection to install only selected software. If you 
choose to install only selected software packages on the server, you must install 
them in the following order: 

■ SUNWsbuc (client software package)

■ SUNWsbus2 (optional device drivers package)

■ SUNWsbun (storage node software package) 

■ SUNWsbus1 (server software package)

4. When you have added all the applicable packages and the prompt is displayed, 
enter q to exit.

5. If you did not specify a set of Solstice Backup servers during the Solstice Backup 
client installation but you want to limit the servers authorized to access the client, 
you can specify a list of trusted Solstice Backup servers for your client using the /
nsr/res/servers file.

# cp /etc/rpc /etc/rpc.old

# cp /etc/syslog.conf /etc/syslog.conf.old

# pkgadd -d /cdrom/6.0.SBU/SOLARIS/Sparc
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Note: You can also use the following procedure to change the set of Solstice 
Backup servers that are authorized to access this client.

a. Shut down the Solstice Backup daemons. For example:

# nsr_shutdown

b. Edit or create the /nsr/res/servers file and add the set of Solstice Backup 
servers, one per line, that you want to grant access to this client. The first entry 
in this file becomes the default Solstice Backup server. 

c. Check the Solstice Backup boot-time startup file for nsrexecd -s arguments. 
If they exist, delete the -s arguments. The nsrexecd -s argument supercedes 
the /nsr/res/servers file. 

For example, delete the arguments for nsrexecd -s in the file shown below:

# vi /etc/init.d/networker

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

d. Use the Solstice Backup boot-time startup file to restart the Solstice Backup 
software. For example:

# /etc/init.d/networker start

6. Verify that the Solstice Backup daemons shown in TABLE 2-2 are running. Enter 
the following command at the system prompt:

# ps -ef | grep nsr

TABLE 2-2 Solstice Backup Daemons

Solstice Backup Installation Packages Solstice Backup Daemons

Solstice Backup server nsrd, nsrexecd, nsrindexd, nsrmmdbd, 
nsrmmd

Solstice Backup client nsrexecd

Solstice Backup storage node nsrexecd, nsrmmd

$PATH:/usr/bin/nsr:/usr/sbin/nsr
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Installing to a Nondefault Location
By default, the Solstice Backup software is installed in the /usr directory. If you 
have insufficient disk space on the /usr partition, you can relocate the following 
Solstice Backup packages to a specified directory on another partition:

■ SUNWsbuc (client software package)

■ SUNWsbun (storage node software package)

■ SUNWsbus1 (server software package)

The following Solstice Backup packages are not relocatable; they are always installed 
in the default location:

■ SUNWsbum (optional Solstice Backup man pages) 

■ SUNWsbus2 (optional Solstice Backup device driver commands, libraries, and 
utilities)

For a listing of the default locations and size requirements, see TABLE 2-1.

Caution – Do not relocate any of the packages if Legato NetWorker Module 
software is also installed on the computer.

▼ To Install the Relocatable Solstice Backup Packages to a 
Nondefault Location

1. Edit the /var/sadm/install/admin/default file. First, create a temporary 
copy of the file by entering the following at the command line:

Next, edit the /var/sadm/install/admin/default file and change the value 
assigned to the basedir variable from default to ask, as shown:

Caution – To successfully install the SUNWsbus2 package, you must provide the 
root directory (/) as the response to the query about which directory to install the 
device drivers in.

cp /var/sadm/install/admin/default /tmp/default.tmp

basedir=ask
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2. Create a directory and the /bin/nsr and /sbin/nsr subdirectories where you 
will install the Solstice Backup packages, for example:

3. Modify the root PATH variable to include the /bin and /sbin subdirectories of 
the directory just created, for example:

4. Enter the pkgadd command:

5. When the following prompt appears in the script, enter the same base directory 
for all the relocated packages:

6. When you have added all the applicable and packages and the prompt is 
displayed, enter q to exit.

If you use pkgrm to remove the packages at a later date, you must also supply the 
base directory you specified.

Autochanger
The following sections provide information on installing and configuring 
autochangers:

■ “About the Term Autochanger” 

■ “Autochanger Configuration and Testing” 

# mkdir /my-path/sbin/nsr

# mkdir /my-path/bin/nsr

/my-path/bin/nsr:/my-path/sbin/nsr

# pkgadd -d /cdrom/6.0.SBU/SOLARIS/Sparc

Enter path to package base directory (default: /usr) [?,q] /my-path 

Using </my-path> as the package base directory.
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About the Term Autochanger
The term “autochanger” is used in the instructions that follow to refer to a variety of 
backup devices: 

■ Autoloader

■ Carousel

■ Library

■ Near-line storage

■ Datawheel

■ Jukebox

For more information on which autochangers are supported on which platforms and 
operating systems, refer to the Legato Compatibility Guides.

You must use a nonrewinding device for Solstice Backup backups. Solstice Backup 
software uses the following naming standard to indicate a nonrewinding device:

Autochanger Configuration and Testing
Follow the instructions in this section to configure and test the device driver 
software on a Solstice Backup server or storage node with an attached autochanger. 
For more detailed information, refer to the autochanger chapter in the Solstice Backup 
6.0 Administrator’s Guide.

To use an autochanger for Solstice Backup storage management, follow the 
procedures for these tasks:

■ “To Configure The Autochanger” 

■ “To Test The Autochanger Connection” 

▼ To Configure The Autochanger

1. Log in as root on the Solstice Backup server.

2. Enter the jbconfig command. The program displays a list of autochangers. For 
more information about the jbconfig command, refer to the jbconfig man 
page.

3. When prompted, indicate which autochanger to install. 

no_rewind_example=/dev/tm0n
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4. Continue to provide the appropriate responses when prompted. To configure a 
SCSI or SJI autochanger, refer to the Solstice Backup 6.0 Administrator’s Guide

When the configuration is complete, the program displays the following message:

When you use the jbconfig program to configure an autochanger, a new resource 
is created with the name you specified. To view the:

■ New resource created in the Jukeboxes’ resource, use the Solstice Backup 
Administration program. 

■ Attributes of the Jukeboxes’ resource, refer to the online help or the 
nsr_jukebox(5) man page.

For more information on configuring an autochanger, refer to the Solstice Backup 6.0 
Administrator’s Guide.

▼ To Test The Autochanger Connection

1. Log in as root on the Solstice Backup server or storage node.

2. Insert two volumes, one each into the first and last slots of the autochanger. Make 
sure that the drives are empty and that any drive doors are open.

3. Enter the jbexercise command at the prompt; specify the control port and the 
device type.

The control port for SCSI autochanger models is typically expressed in the format 
scsidev@n.n.n. You can obtain the exact control port pathname from the 
response displayed by the jbconfig command script:

For example, the following command runs the jbexercise program on the 
Quantum DLT/Digital DLT autochanger detected by the jbconfig script:

Jukebox has been added successfully.

These are the SCSI Jukeboxes currently attached to your system

1) scsidev@1.2.0: DLI Libra Series

2) scsidev@0.2.1: Quantum DLT/Digital DLT

# jbexercise -c scsidev@0.2.1 -m “Quantum DLT/Digital DLT”
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For additional information on the command options available for the 
jbexercise command, refer to the jbexercise(1m) man page.

Verifying Your Installation
The following sections provide information about the Solstice Backup GUI and 
starting and testing the installation:

■ “About the Solstice Backup GUI” on page 23

■ “Starting the Solstice Backup GUI” on page 23

■ “Testing Solstice Backup Software” on page 24

About the Solstice Backup GUI
The Solstice Backup software includes both a GUI and a command line interface. Use 
the GUI for the following procedures. To learn more about the command line 
interface, refer to the nsradmin(8) man page.

The speedbar buttons displayed in the main window of the GUI provide quick 
access to the most frequently performed Solstice Backup administration tasks.

The program’s online help is available through the Help menu. You can view a topic 
that is specific to the window or scroll to another topic of your choice.

Starting the Solstice Backup GUI 
To start the Solstice Backup GUI, enter the nwadmin command at the shell prompt:

If the Solstice Backup GUI is not displayed, try one of the following:

■ Check that the DISPLAY environment variable is set correctly.

■ Check that the PATH environment variable contains the correct path to the 
Solstice Backup programs.

If the Solstice Backup GUI cannot connect to the specified server:

# nwadmin -s server-name &
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■ Run the ps command to check that the required Solstice Backup daemons, nsrd 
and nsrexecd, are present. 

■ If the output does not list nsrd and nsrexecd as current processes, run the 
following command to start the Solstice Backup daemons:

Testing Solstice Backup Software
When you installed the package on the Solstice Backup server, the program 
automatically:

■ Added the server hostname to the list of Solstice Backup clients.

■ Specified the option save set “all”. This specifies that all save sets on the server 
are backed up.

When testing the Solstice Backup software, consider the following:

■ You can use the default setup provided by the installation to test the software and 
device connections, or modify the options before you perform the test.

■ To use a device in an autochanger, use the configuration instructions provided in 
the Solstice Backup 6.0 Administrator’s Guide.

▼ To Test of the Solstice Backup Software on Stand-alone 
Devices Only

1. Insert a volume into the device you configured for Solstice Backup software. 

2. Label the volume with the Default label template:

a. Select Label from the main window. The Solstice Backup application displays 
the preconfigured label templates.

b. Click OK.

3. Mount the volume in the drive:

a. Select Mount from the main window.

b. Highlight the volume you labeled in step 2.

c. Click OK.

# ps -ef | grep nsr

# /etc/init.d/networker start
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4. Test the group backup:

a. Select Customize>Groups from the main window. The default group is 
highlighted.

b. Select Enabled in the Autostart group.

c. Return to the main window.

d. Select Group Control from the main window. The Group Control window 
appears with the Default group highlighted. 

e. Click Start.

To view the progress of your test backup, select Details. Messages appear in 
the panels of the main window as the backup progresses.

5. View the client file index entries, made for the server during the test backup, by 
selecting Indexes.

If the test backup was not successfully completed, refer to the troubleshooting 
information in the Solstice Backup 6.0 Administrator’s Guide to determine the cause.

Removing the Solstice Backup Software
Use the pkgrm command to remove individual Solstice Backup packages or all of the 
Solstice Backup packages at the same time.

Caution – The Solstice Backup software packages depend on each other. To remove 
them all, you must remove them in the following order: SUNWsbus1, SUNWsbun, 
SUNWsbus2, SUNWsbuc. The man pages (SUNWsbum) and document files have no 
dependencies—you can remove them at any time.

▼ To Remove the Solstice Backup Software Packages

1. Log in as root on the system where you are removing the software.

2. Enter the nsr_shutdown command to shut down the Solstice Backup daemons. 
A list of Solstice Backup daemons that will be shut down appears, along with a 
prompt that asks whether you want to continue with the nsr_shutdown 
command.

3. Enter the pkgrm command to remove the software. For example:
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■ To remove all the packages, enter:

Caution – Do not choose the default option “all” to remove the Solstice Backup 
software packages. Choosing this option removes all the software packages (not just 
Solstice Backup software) that were installed on your computer using the pkgadd 
utility.

■ To remove only the:
– Server software, enter the pkgrm SUNWsbus1 command. 
– Storage node software, enter the pkgrm SUNWsbun command.
– Device driver software, enter the pkgrm SUNWsbus2 command. This removes 
the SUNWsbus2 package from the server or storage node where the device driver 
software is installed.
– Client software, enter the pkgrm SUNWsbuc command. 
– Solstice Backup man pages, enter the pkgrm SUNWsbum command. This 
removes the SUNWsbum package from the server, storage node, or client where 
the man pages are installed.

# pkgrm SUNWsbus1 SUNWsbun SUNWsbus2 SUNWsbuc SUNWsbum
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CHAPTER 3

Installing Solstice Backup Software 
in a Sun Cluster Environment

This chapter explains how to install Solstice Backup software in a Sun Cluster 
environment. It includes the following sections:

■ “Software Installation Roadmap” 

■ “Installation Requirements” on page 28

■ “Installing a Solstice Backup Cluster-Aware Server” on page 31

■ “Installing Only the Solstice Backup Client Software” on page 37

■ “Upgrading an Existing Solstice Backup Server to a Cluster-Aware Server” on 
page 41

■ “Relocating the Solstice Backup Virtual Server” on page 43

■ “Shutting Down and Restarting the Cluster Server” on page 44

■ “Solstice Backup Cluster Script” on page 45

A Sun Cluster consists of multiple nodes (physical hosts) in a networked 
configuration and provides additional security with the failover capability. Failover 
allows another node in the cluster to take over operations from the first node. For 
more detailed information about the Sun Cluster, refer to the Sun Cluster System 
Administration Guide.

Software Installation Roadmap
The following tasks are a roadmap to follow when installing the Solstice Backup 
software. Read the roadmap and the referenced sections before installing the 
software.
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1. Review the requirements section and note the default directory location. For more 
information, see “Installation Requirements” on page 28.

2. If you have an earlier release of the Solstice Backup software installed, see 
“Updating from a Previous Release” on page 9.

3. Install the required Solstice Backup software. For more detailed information, see 
one of the following sections:

■ “Installing a Solstice Backup Cluster-Aware Server” on page 31

■ “Installing Only the Solstice Backup Client Software” on page 37

4. Enable and register all of your Solstice Backup products. For more information, 
see Chapter 4.

Installation Requirements
The following sections discuss the software and hardware requirements for setting 
up Solstice Backup software as a high availability application in a Sun Cluster 
environment:

■ “Software Requirements” 

■ “Hardware Requirements” 

■ “System Information Requirements” 

For the most up-to-date information regarding software and hardware requirements, 
refer to the Legato Compatibility Guides.

Software Requirements
To install a Solstice Backup cluster server, make sure that the following software is 
installed on each node in the cluster:

■ SunOSTM

■ Sun Cluster and Logical Volume Manager

■ Solstice Backup version 6.0

■ Software listed in “Installation Requirements” on page 6
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Hardware Requirements
To install the Solstice Backup software, make sure that the following hardware 
requirements are met for each node in the cluster:

■ The cluster server’s /nsr directory (/virtual_host_name/nsr) must 
contain sufficient space for the Solstice Backup virtual server to operate. In other 
words, the virtual host must have sufficient space within its disk group(s) to 
contain /virtual_host_name/nsr.

■ Hardware requirements listed in “Installation Requirements” on page 6.

System Information Requirements
FIGURE 3-1 and TABLE 3-1 display the system information needed to install the 
Solstice Backup cluster server.

Different platforms use different terms for the same cluster concepts. Sun Cluster 
refers to:

■ Physical hosts as nodes

■ Virtual server as an agent
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FIGURE 3-1 Sample Cluster Configuration

TABLE 3-1 Required Information

Information Required Example

Solstice Backup virtual host with IP address in 
the same subnet as the cluster nodes 

clus_vir1, 16.64.96.31

Solstice Backup package mount point for 
virtual volume

/clus_vir1

Solstice Backup cluster configuration script /usr/sbin/nsr/networker.cluster

Solstice Backup start method script /usr/sbin/nsr/networker.start

Solstice Backup stop method script /usr/sbin/nsr/networker.stop

Solstice Backup fault method start script /usr/sbin/nsr/networker.fm_start

Solstice Backup fault method stop script /usr/sbin/nsr/networker.fm_stop

Node A
clus_phys1

Node B
clus_phys2

Private Network

Local
Disk 1

Local
Disk 2

clus_vir1

Solstice Backup
Virtual Server

If Node A fails, 
clus_vir1 fails 

over to Node B

Public Network

Volume-Managed Shared Disks

Terminal Concentrator

Administrative
Workstation

Cluster
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Installing a Solstice Backup Cluster-
Aware Server
To install and configure the Solstice Backup software as a high availability 
application in a Sun Cluster environment, follow these procedures:

■ “To Install the Solstice Backup Software on All Cluster Nodes” 

■ “To Define the Solstice Backup Server as a High Availability Application” on 
page 32

■ “To Configure the Solstice Backup Cluster Server” on page 33

■ “To Configure Clients under the Solstice Backup Cluster Server” on page 34

■ “To Register Solstice Backup Licenses for Cluster Server Failover” on page 36

For detailed information about how to configure virtual hosts, or for general Sun 
Cluster information, refer to the Sun Cluster 2.2 System Administration Guide.

▼ To Install the Solstice Backup Software on All 
Cluster Nodes
Because the installation procedure varies little for installing servers and storage 
nodes, the instructions are presented together in this section.

1. Log in as root on the system where you want to install the Solstice Backup 
software.

Change directories to the location of the Solstice Backup software distribution 
files. For installation from a local or remote CD-ROM, mount the Solstice Backup 
CD and then change directories to where it is mounted.

For more information, see one of the following sections:

■ “To Access Installation Files From a Local CD-ROM” on page 14

■ “To Access Installation Files From a Remote CD-ROM” on page 14

2. To start the installation, enter the following command at the system prompt:

# pkgadd -d .
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▼ To Define the Solstice Backup Server as a High 
Availability Application
To define the Solstice Backup software as a high availability application, you must 
run the networker.cluster script (located in the /usr/sbin/nsr directory) 
on each host within the cluster.

1. Log in as root.

2. Make sure that the /etc/hosts file on each cluster node contains the name of 
the virtual host.

3. Run the cluster configuration script, /usr/sbin/nsr/networker.cluster 
on each node in the cluster that will run the Solstice Backup server process. For 
more information, see “Solstice Backup Cluster Script” on page 45.

Note: If you make mistakes during this configuration step, you can undo any 
configuration by using the -r option from the root directory.

a. On each node, you are prompted for the location of the local Solstice Backup 
database directory provided during the installation procedure. If it is not /nsr, 
/nsr will be a symbolic link to this directory.

b. In response to the networker.cluster script prompt, enter the name for the 
virtual host. 

c. On the node that currently masters the virtual host, the configuration script 
prompts for confirmation that all the cluster nodes have been configured. 
– Answer yes after all nodes have been configured.

or 
– Answer no to get the hareg commands that are required once the cluster has 
been fully configured.

Caution – In general, it is best to configure last the node mastering the virtual host 
to associate with the Solstice Backup virtual server. You can also use the Cluster 
Console GUI to run the configuration simultaneously on all cluster nodes.

Task 3: Define the List of Trusted Solstice Backup 
Servers
To define the list of trusted Solstice Backup servers:
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1. On one node in the cluster, shutdown the Solstice Backup service using the 
cluster management software.

2. On each node in the cluster:

a. Edit or create the /nsr/res/servers file and add the set of Solstice Backup 
servers, one per line, that you want to grant access to this client.

Note: Make sure that the first entry in this file is the virtual hostname for the 
Solstice Backup service. This entry becomes the default Solstice Backup server.

b. Check the Solstice Backup boot-time startup file for nsrexecd -s arguments. 
If they exist, delete the -s arguments. The nsrexecd -s argument supercedes 
the /nsr/res/servers file. 

For example, delete the arguments for nsrexecd -s in the file shown below:

# vi /etc/init.d/networker

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

c. Use the Solstice Backup boot-time startup file to stop and restart the Solstice 
Backup software. For example:

# /etc/init.d/networker stop

# /etc/init.d/networker start

3. On one node in the cluster, start the Solstice Backup service using the cluster 
management software.

4. On the node that is running the Solstice Backup server:

a. Edit or create the /nsr/res/servers file and add the set of Solstice Backup 
servers, one per line, that you want to grant access to this client.

b. Make sure that the first entry in this file is the virtual hostname for the Solstice 
Backup service. This entry becomes the default Solstice Backup server.

c. Shut down and restart the Solstice Backup service using the cluster 
management software.

▼ To Configure the Solstice Backup Cluster Server
After you install and configure the Solstice Backup software as a high availability 
application, you must configure the Solstice Backup server. 
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1. Log in to the cluster node that masters the Solstice Backup virtual server.

2. Modify the server resource:

a. Open the Solstice Backup nwadmin GUI Server window.

b. From the main menu, select Server Setup.

c. In the Administrator attribute, add any cluster nodes that are not already 
listed.

d. Click Add and select Apply to apply your changes.

▼ To Configure Clients under the Solstice Backup 
Cluster Server
When you install the Solstice Backup 6.0 software on a cluster node, the installation 
program creates the /nsr link to point to a local disk. It also creates a second link 
to the local Solstice Backup directory named nsr.Backup.local. For example, if 
the local Solstice Backup directory was created in /var/nsr, each client node has 
the following links:

■ /nsr->/nsr.Backup.local

■ /nsr.Backup.local->/var/nsr

To make the cluster node a client of the Solstice Backup cluster server:

1. Make each physical node within the cluster a Solstice Backup client of the virtual 
Solstice Backup server:

a. Using the nwadmin GUI, select Client> Clients Setup.

b. Click Create and enter the name of the physical host in the Name field.

c. Complete the remaining fields in the Client window.

d. Repeat steps a-c for each physical node in the cluster.

2. Make each virtual host within the cluster a Solstice Backup client of the virtual 
Solstice Backup server:

a. Using the nwadmin GUI, select Client> Clients Setup.

b. Click Create and enter the name of the virtual server in the Name field.

c. In the Remote Access field, enter the user@hostname of each physical node 
within the cluster. For example:

root@clust_phy1
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d. Complete the remaining fields in the Client window.

e. Repeat steps a-d for each virtual node in the cluster.

3. Define save groups as required.

a. Open the Solstice Backup nwadmin GUI Server window.

b. Select Customize>Groups from the main menu. 

c. Select View>Details from the main menu.

d. Click Create to create a new save group. Complete the appropriate fields.

e. For each save group, click Enabled in the Autorestart field.

f. For each save group, make sure that the Manual Restart option is unchecked in 
the Options field.

Caution – The only save sets that will be restarted after a virtual client or Solstice 
Backup server failover are those that belong to a save group where the Autorestart 
attribute is enabled and the Manual Restart option is disabled.

4. Change the server’s save set value from All to another value, such as the shared 
filesystems associated with the Solstice Backup virtual host (refer to the 
appropriate file in /etc/opt/SUNWcluster/conf/hanfs).

Note: To restrict the set of Solstice Backup servers that can back up a particular 
client, edit the /nsr/res/servers file and add the Solstice Backup virtual host 
as well as each cluster node to the list of servers.

5. Verify that the client and group resources have been properly configured by 
running a test probe. On the node on which the Solstice Backup server resides, 
run the following command:

If the test probe does not display the scheduled back ups and index you had 
wanted, you can complete one of the following:

■ Reconfigure the cluster.

or 

■ Enter the following command to bypass the default ownership scheduling 
rules:

# touch networker_bin_dir/pathownerignore

# savegrp -pv -c client_name group_name
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This command allows any paths to be scheduled for back ups for a Solstice 
Backup client.

Note: A Solstice Backup scheduled save might use a client index name other than 
the one you want it to. To override this default, run a manual save with the -c 
option or run the following command as a cron job. For example:

When Task 3 is completed:

■ The Solstice Backup cluster server uses the IP address of the Solstice Backup 
virtual host regardless of which cluster node currently masters the Solstice 
Backup virtual server.

■ The Solstice Backup cluster server takes the identity of the Solstice Backup virtual 
server’s hostname regardless of which cluster node is currently running the 
Solstice Backup service.

■ The first time Solstice Backup software runs, it creates the client resource for the 
Solstice Backup virtual host. Client resources must be created manually for any 
cluster node to be backed up by the Solstice Backup virtual host.

▼ To Register Solstice Backup Licenses for Cluster 
Server Failover
1. Make sure that you have already defined the Solstice Backup virtual server as 

part of a cluster.

2. Make sure that the Solstice Backup service is running.

3. Log on to the system running the Solstice Backup virtual server.

4. Create a file named /nsr/res/hostids that contains the hostids of all the 
cluster nodes, using the following syntax: hostid1:hostid2:hostid3:... 

For example:

12345678:87654321

5. Run the hostid command on each cluster node to find the hostid values.

# save -c desired_client_name
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6. Restart the server by taking the virtual server offline and then putting it back 
online. For example:

7. Register the Solstice Backup software. For details, see Chapter 4.

Customer Service will then send you your authorization codes using your 
composite hostid. Your composite hostid was created after step 4.

Installing Only the Solstice Backup 

Client Software
■ To install a Solstice Backup cluster client, “Define the List of Trusted Solstice 

Backup Servers” on page 38

follow these procedures:

■ “To Install the Solstice Backup Cluster Client Software” 

■ “To Configure Solstice Backup Client Software as Cluster-Aware” 

■ “To Configure the Clients under the Solstice Backup Server” on page 39

▼ To Install the Solstice Backup Cluster Client 
Software
1. Log in as root on the system where you want to install the Solstice Backup 

software.

Change directories to the location of the Solstice Backup software distribution 
files. For installation from a local or remote CD-ROM, mount the Solstice Backup 
CD and then change directories to where it is mounted.

For more information, see one of the following sections:

■ “To Access Installation Files From a Local CD-ROM” on page 14

■ “To Access Installation Files From a Remote CD-ROM” on page 14

% hareg -n networker

% hareg -y networker 
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2. To start the installation, enter the following command at the system prompt:

3. Make sure that the following steps have been performed:

a. Install the client software on every node in the cluster that you want to back 
up.

b. Configure both physical and virtual client resources.

▼ To Configure Solstice Backup Client Software as 
Cluster-Aware
To define the Solstice Backup application as a cluster-aware application, run the 
networker.cluster script (located in the /usr/sbin/nsr directory) on each 
physical host within the cluster. 

1. Log in as root.

2. Make sure that the /etc/hosts file on each cluster node contains the name of 
the virtual host. You can also publish the virtual hostname in DNS or NIS.

Define the List of Trusted Solstice Backup Servers
To define the list of trusted Solstice Backup servers:

1. On one node in the cluster, shutdown the Solstice Backup service using the 
cluster management software.

2. On each node in the cluster:

a. Edit or create the /nsr/res/servers file and add the set of Solstice Backup 
servers, one per line, that you want to grant access to this client.

Note: Make sure that the first entry in this file is the virtual hostname for the 
Solstice Backup service. This entry becomes the default Solstice Backup server.

b. Check the Solstice Backup boot-time startup file for nsrexecd -s arguments. 
If they exist, delete the -s arguments. The nsrexecd -s argument supercedes 
the /nsr/res/servers file. 

For example, delete the arguments for nsrexecd -s in the file shown below:

# pkgadd -d SUNWsbuc SUNWsbum
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# vi /etc/init.d/networker

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

c. Use the Solstice Backup boot-time startup file to stop and restart the Solstice 
Backup software. For example:

# /etc/init.d/networker stop

# /etc/init.d/networker start

3. On one node in the cluster, start the Solstice Backup service using the cluster 
management software.

4. On the node that is running the Solstice Backup server:

a. Edit or create the /nsr/res/servers file and add the set of Solstice Backup 
servers, one per line, that you want to grant access to this client.

b. Make sure that the first entry in this file is the virtual hostname for the Solstice 
Backup service. This entry becomes the default Solstice Backup server.

c. Shut down and restart the Solstice Backup service using the cluster 
management software.

▼ To Configure the Clients under the Solstice 
Backup Server
Note: The Solstice Backup server might reside outside of the cluster.

To configure the Solstice Backup server:

1. Log in to the cluster node that is running the Solstice Backup server.

2. Make each physical node within the cluster a client of the Solstice Backup server. 
For each physical node:

a. Using the nwadmin GUI, select Client> Clients Setup.

b. Click Create and enter the name of the physical host in the Name field.

c. Complete the remaining fields in the Client window.

3. Make each virtual host within the cluster a client of the Solstice Backup server:

a. Using the nwadmin GUI, select Client> Clients Setup.
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b. Click Create and enter the name of the Solstice Backup server in the Name 
field.

c. In the Remote Access field, enter the user@hostname of each physical node 
within the cluster. For example:

root@clust_phy1

d. Complete the remaining fields in the Client window.

e. Repeat steps a-d for each virtual node in the cluster.

4. Define save groups as required.

a. Open the Solstice Backup nwadmin GUI Server window.

b. Select Customize>Groups from the main menu. 

c. Select View>Details from the main menu.

d. Click Create to create a new save group. Complete the appropriate fields.

e. For each save group, click Enabled in the Autorestart field.

f. For each save group, make sure that the Manual Restart option is unchecked in 
the Options field.

Caution – The only save sets that will be restarted after a virtual client failover are 
those that belong to a save group where the Autorestart attribute is enabled and the 
Manual Restart option is disabled.

5. Change the server’s save set value from All to another value, such as the shared 
filesystems associated with the Solstice Backup virtual host (refer to the 
appropriate file in /etc/opt/SUNWcluster/conf/hanfs).

6. Verify that the client and group resources have been properly configured by 
running a test probe. On the node on which the Solstice Backup server resides, 
run the following command:

If the test probe does not display the scheduled back ups and index you had 
wanted, you can complete one of the following:

■ Reconfigure the cluster.

or 

■ Enter the following command to bypass the default ownership scheduling 
rules:

# savegrp -pv -c client_name group_name
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# touch networker_bin_dir/pathownerignore

This command allows any paths to be scheduled for back ups for a Solstice 
Backup client.

Note: A Solstice Backup scheduled save might use a client index name other than 
the one you want it to. To override this default, run a manual save with the -c 
option or run the following command as a cron job. For example:

Note: To restrict the set of Solstice Backup servers that can back up a particular client, 
edit the /nsr/res/servers file and add the Solstice Backup host to the list of 
servers.

Upgrading an Existing Solstice Backup 
Server to a Cluster-Aware Server
You can upgrade an existing Solstice Backup server (where the computer is the node 
within the cluster) to a cluster-aware server. To upgrade, you must install the 
Solstice Backup 6.0 software as a cluster server.

Caution – You can migrate a noncluster Solstice Backup server to a Solstice Backup 
cluster server only if the Solstice Backup storage device used on the existing server is 
one of the devices supported for cluster server failover.

▼ To Migrate the Existing Server Indexes, Media 
Database, and Resource File
1. Use the following command to remove the existing version of the Solstice Backup 

software:

Note: Do not remove the old /nsr directory.

# save -c desired_client_name

# pkgrm SUNWsbus1 SUNWsbun SUNWsbus2 SUNWsbuc SUNWsbum
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2. Preserve the link to the old /nsr directory (located on the old server local disk). 
Enter the following command:

3. Install and configure the Solstice Backup software as a cluster server. This 
includes connecting the Solstice Backup shared disk to a shared bus in the cluster. 
See the following sections for detailed instructions:

■ “To Configure the Solstice Backup Cluster Server” 

■ “To Configure Clients under the Solstice Backup Cluster Server” 

4. Make sure that the Solstice Backup software is running on the cluster node where 
the old /nsr directory is located. If it is not, then relocate the directory.

5. On the cluster node running the Solstice Backup virtual server, do the following, 
as root:

a. Stop all Solstice Backup activity by entering the following commands:

b. Remove the default resources that were created when the Solstice Backup 
virtual server was defined. Enter the following command:

6. Migrate the indexes, media database, and resource files from the old server to the 
Solstice Backup cluster server /nsr directory, now located on a shared disk, by 
following these tasks:

a. Create a Solstice Backup directive file (for example, /tmp/directive) on 
your source system. Enter these lines in the file:

<</>>

forget

ignore

+skip: core

+skip: db.*

# mv /nsr /nsr.old

# hareg -n networker

# nsr_shutdown

# rm -rf /nsr/*
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b. Change to the /nsr directory and use the uasm command to move the files 
from one directory to the other:

# cd /nsr.old

# uasm -s -f /tmp/directive . | (cd /nsr; uasm -rv)

7. After migrating your indexes:

a. Start the Solstice Backup software on the new server. 

b. Configure all the devices, including any jukeboxes, for the new server.

8. Take the Solstice Backup virtual server offline and then put it back online:

9. Remove any old device and jukebox resources and reconfigure them to reflect 
their new location on the shared bus.

Relocating the Solstice Backup Virtual 
Server
Each time the Solstice Backup virtual server is relocated, the Sun Cluster software 
shuts down all the Solstice Backup daemons on the cluster node running the Solstice 
Backup virtual server. It then restarts nsrexecd on that system. 

The Sun Cluster software then relocates the Solstice Backup virtual server to the 
assigned cluster node. The /nsr link is redefined to point to the Solstice Backup 
virtual server shared disk: /nsr -> /virtual_host_name/nsr. Using the 
previous cluster example on page 34, the link to the /nsr directory is:

■ On the cluster node running the Solstice Backup virtual server:

/nsr->/clus_log1/nsr

/nsr.Backup.local->/var/nsr

■ On each cluster node not running the Solstice Backup virtual server:

/nsr->/nsr.Backup.local

/nsr.Backup.local->/var/nsr

# hareg -n networker

# hareg -y networker
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Sun Cluster will not relocate the Solstice Backup virtual server if the storage disk is 
busy (which could happen if a user has changed to a directory on that filesystem).

Shutting Down and Restarting the 
Cluster Server
To shut down the Solstice Backup daemon on the cluster server, take the Solstice 
Backup virtual server offline by running the hareg -n command. This cleanly stops 
all Solstice Backup server activity.

To restart the Solstice Backup daemons on a cluster server manually, set the Solstice 
Backup virtual server online by running the hareg -y command.

Deinstalling and Reinstalling the Cluster 
Server Subset
This section explains how to deinstall and reinstall a cluster server subset. It contains 
the following sections:

■ “Deinstalling” 

■ “Reinstalling” 

Deinstalling
Deinstalling the cluster server subset runs the /usr/sbin/nsr/
networker.cluster -r command as part of its cleanup. This turns off and then 
deregisters the Solstice Backup server when you remove the server subset on the 
node which presently masters the Solstice Backup virtual server.

To deinstall the server subset on a cluster node, remove the subsets for the server, 
client, and storage node with the pkgrm command.
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Reinstalling
To reinstall the server subset on a cluster node: 

1. Take the Solstice Backup virtual server off line using the hareg -n command.

2. Remove the Solstice Backup server subset using the pkgrm command.

3. Reinstall the Solstice Backup server subset.

4. Reconfigure the cluster node using the /usr/sbin/nsr/networker.cluster 
script.

If the node where you are reinstalling the subset masters the virtual host of the 
Solstice Backup virtual server, the virtual server will be re-registered and started.

Solstice Backup Cluster Script
This example, generated when you run the networker.cluster script, uses the 
following configuration:

■ Two cluster nodes:

– clus_phys1: IP address 16.64.96.28

– clus_phys2: IP address: 16.64.96.30
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■ Solstice Backup virtual host: clus_vir1: IP address 16.64.96.31

---------------------------------------------------------------

Sun Cluster 2.x installations have a hierarchy of cluster objects 
which define high available agents. Each agent is associated with 
a virtual host that encapsulates agents and disk groups which may 
fail over from one physical host to the next, depending on the 
availability and health of the machine it is running upon. When a 
failover occurs, this virtual host moves, taking with it its agents 
and disk groups.
To complete this procedure, one must have a virtual host defined 
on which the NetWorker agent can be entered.
---------------------------------------------------------------

Do you wish to continue? [Yes]? yes
Enter directory where local NetWorker database is installed [/
nsr]? /var/nsr
Enter virtual host to register networker agent under? clus_vir1
Have all cluster nodes that can master clus_log1 been configured 
[No]? yes
registering networker agent...

Apr 15 10:00:58 clus_phys1 ID[SUNWcluster.ha.hareg.3024]: (info) 
Agent networker is registered
activating networker agent...
Apr 15 10:01:09 clus_phys1 ID[SUNWcluster.ha.hareg.1008]: (info) 
Agent networker successfully turned on
done.
NetWorker has been successfully cluster configured



47

CHAPTER 4

Enabling, Registering, and 
Authorizing Solstice Backup 
Software

This chapter provides information for enabling your Solstice Backup software for 
purposes of evaluation and permanent registration. It includes the following 
sections:

■ “Enabler Codes for Purchased Software” 

■ “Enabler Codes for Evaluated Software” on page 49

■ “Purchasing an Enabler Certificate” on page 51

■ “Registering and Authorizing the Software for Permanent Use” on page 51

■ “Managing Your Sun Licenses” on page 53

Enabler Codes for Purchased Software
To permanently use Solstice Backup software, you must purchase an enabler code 
that permits you to use the software at one of three levels.

TABLE 4-1 Software Versions

Software Version Purchased Features

WorkGroup EditionTM • Backs up and recovers data from the server and 
up to three client connections of the same platform.
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How you enable the Solstice Backup software depends on whether the software you 
purchased is a first-time purchase, or an updated or upgraded version. See the 
following table to determine where to obtain the appropriate enabler code:

Once you enable the software, you have 45 days to register it. After you register the 
product, Sun will send you an authorization code which permanently enables 
Solstice Backup software.

Network Edition • Backs up and recovers data from the server and 
up to nine client connections of the same platform.
• Provides support for additional client connections 
and optional modules.

Power EditionTM • Backs up and recovers data from the server and 
the number of clients’ workstations of the same 
platform allowed by your license. 
• Provides support for additional clients and 
optional modules.
• Tuned for environments with very large databases 
(VLDB) or large filesystem applications (in the 
terabyte range).

TABLE 4-2 Enabler Codes for Purchased Software

If the Solstice Backup software you 
purchased: Then use the enabler code:

Is a first-time purchase of
Solstice Backup software

Found on the Enabler Certificate that was sent 
separately from the product package.

Is an update to your existing Solstice 
Backup software

Provided in the letter announcing the updated 
software release.

Is an upgrade to your existing 
Solstice Backup software

Found on the Enabler Certificate that was sent 
separately from the product package.

Note: You must enter the new enabler code to 
register and authorize Solstice Backup software for 
the upgraded functionality.

TABLE 4-1 Software Versions

Software Version Purchased Features
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Enabler Codes for Evaluated Software
Once you install the Solstice Backup software, you have an allotted period of time in 
which to evaluate it. This evaluation period depends on whether the Solstice Backup 
server is running in evaluation mode, or is authorized.

If the Solstice Backup Server Is Running in 
Evaluation Mode
If you installed the Solstice Backup server software for evaluation purposes, you 
have 30 days to use the software.

During this 30-day evaluation period, you can elect to purchase your Solstice 
Backup product. Once purchased, Sun will issue you another enabler code that will 
permanently enable your Solstice Backup product. For specific rules on the usage of 
enabler codes, contact your Sun sales representative. 

Note: If you have not purchased and entered a permanent enabler code by the end of 
the 30-day evaluation period, you will be unable to continue to back up data and 
recover any data that was backed up during the evaluation period.

Caution – If you move Solstice Backup software from one computer to another, or 
change the network address of a computer after the software is installed, you must 
obtain new authorization code(s). 

To purchase and register your Sun software for permanent use, see the following 
sections for details:

■ “Purchasing an Enabler Certificate” on page 51

■ “Registering and Authorizing the Software for Permanent Use” on page 51

If the Solstice Backup Server Is Permanently 
Enabled and Authorized
If you already have the Solstice Backup server software enabled and want to evaluate 
any of the optional modules included with this software distribution:

1. Make sure that your Solstice Backup server software is enabled.



50 Solstice Backup 6.0 Installation Guide • November 2000

2. Enter the evaluation enabler code (shown in TABLE 4-3) for the product you want 
to evaluate. 

After entering the enabler code, you can evaluate the product for 45 days.

Caution – The evaluation enabler codes cannot be entered on more than one 
computer on the network. If you enter the code on more than one computer on the 
same network, a copy violation error occurs and the Solstice Backup server software 
is disabled.

Caution – If you have already entered a Network or WorkGroup Edition base 
enabler, you cannot enter a Power Edition evaluation enabler on a computer. To 
evaluate Power Edition in an existing Solstice Backup environment, you must delete 
the base enabler. Call Technical Support for instructions.

To purchase and register your Sun software for permanent use, see the following 
sections for details:

■ “Purchasing an Enabler Certificate” 

■ “Registering and Authorizing the Software for Permanent Use” 

TABLE 4-3 Enabler Codes for Evaluated Software

Solstice Backup Product Part Number 45-Day Evaluation Enabler Code

Autochanger Module, Unlimited 2046 1d14e0-1fd965-193167

Storage Node 1, UNIX Version 2080 9b981d-4b67f8-6a65e1

Storage Node 2, UNIX Version 2080 1c199e-cad879-e9eb66

Storage Node 3, UNIX Version 2080 9c991e-4a58f9-696ae6

100 Client Connections 2023 77e4d7-63d771-728f97

Archive, UNIX Version 2030 da5f5c-9f261d-0c8ba0

Archive, Windows NT Version 2930 3a21bc-ffc67b-9da800

 NetWorker NDMP Connection 2032 ed406f-b10929-cc73b7
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Purchasing an Enabler Certificate
To obtain enabler codes for your Solstice Backup products, contact the Sun License 
Center using one of the following methods:

■ World Wide Web: http://www.sun.com/licensing

■ E-mail: license@Sun.com

■ Voice: 1-801-431-1595

■ Fax:  1-801-431-3657

If you lose your license, you can request another via e-mail at:

lost-license@sun.com.

Also, because Solstice Backup licensing is based on the host id, an affidavit of 
migration must be obtained in order to move the Solstice Backup server to another 
machine. An affidavit of migration can be requested from the Sun License Center at 
the locations listed above. Once the affidavit is completed, the license center will 
issue a new Authorization code.

After you enable the Solstice Backup software, you have 45 days to register it. Sun 
sends a unique authorization code to you after receiving your completed registration 
form.

Registering and Authorizing the 
Software for Permanent Use
At the end of the evaluation period, you must purchase an enabler code and register 
the product to authorize it and use the feature permanently.

You can use one of the following two methods to register and authorize the 
software:

■ “Registering Using the World Wide Web” on page 52

■ “Registering by Fax or E-mail” on page 52
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Registering Using the World Wide Web
You can register and authorize Solstice Backup via the World Wide Web. Solstice 
Backup web authorization can be completed in just a few minutes and is available 24 
hours a day, seven days a week. To register and authorize Solstice Backup via the 
world wide web, simply point your web browser to http://www.sun.com/licensing and 
follow the step-by-step instructions.

Registering by Fax or E-mail
To register and authorize the software by fax or e-mail:

1. Log in as root on the Solstice Backup server.

2. Start the Solstice Backup Administrator program:

3. Open the Server window. Fill in the name, address, phone, and e-mail 
information requested.

4. Open the Registration window and click the Create button.

5. Enter the enabler code in the Enabler Code field.

6. Print the enabler information sheet:

a. Select the Tabular option from the View menu.

b. Select Print from the File menu.

7. Register and authorize your software. You can either:

■ Fax the output from the Registration window to Sun at 1-801-431-3657.

■ E-mail the output from the Registration window to Sun at license@Sun.com.

An authorization code that permanently enables the updated Solstice Backup 
software will be sent for you to enter in the Registration window.

# nwadmin &
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Managing Your Sun Licenses
The License Manager provides a central control point for license management of all 
your Solstice Backup clients and servers. Instead of managing licenses separately, 
you can now maintain all your Solstice Backup licenses from a single computer. 
Installation of the License Manager is an option when installing Solstice Backup 
software. 

Using the License Manager software, you can move the Solstice Backup software 
from one computer to another or use a new IP address on an existing Solstice 
Backup server without having to reauthorize the software. For details on using the 
License Manager, refer to the License Manager Administrator’s Guide.
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